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Operating instructions

WinPP101 test program
Receive, check, filter, store, display, print, transmit and
simulate IEC 60870-5-101 messages.
The program creates a process image
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1 Installation

Note: For the driver installation you must log on as Administrator.

System Requirements: Windows 7, Vista or XP, Pentium, 100 MB RAM, 100 MB Disc, VGA 
or better, at least one COM port (USB-Serial is possible) and USB port for dongle.

The setup program of WinPP101 is delivers on CD. On the CD the program is in the folder 
“Programme”.
The file name is SetupWinPP101vnnnn.exe, nnnn stands for program version.
Par example: SetupWinPP101v2300.exe = Setup program for WinPP101 Version 2.3.0.0.

Insert the CD into the drive and start the program "SetupWinPP101vnnnn.exe“, then follow 
the instructions on the screen.

The program makes an entry in the Program directory of the Start Menu for starting 
WinPP101. You can uninstall WinPP101 via the dialogue field "Properties of Software” 
(Menu: Start | Settings | System Control | Software).

After installation the following files are in the chosen directory:

WinPP101.exe Test program 
W101Text.ger Program texts in German
W101Text.usa Program texts in English
W101Ger.chm German Online Help
W101Usa.chm English Online Help
Bed101Ger.pdf German operating instructions
Bed101Usa.pdf English operating instructions
CbSetup.exe Auxiliary program, installs the dongle driver.
ExText1.csv File example for text of objects.
Typ1Ger.csv File example for short texts of message types, German.
Typ1Usa.csv File example for short texts of message types, English.
1Version.txt Versions log of WinPP101 (German).
Log.lg1 Standard Log file for online messages.
SeTel.st1 Standard file for transmission messages and lists.

You can also save Log files, and the files for transmission messages and lists, under your 
own choice of name for reloading later. Do not add the file extensions ("lg1” or "st1”) as the 
program automatically append them.

On exiting the program it saves the configuration specific to your PC in the file W101.cfg.
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2 Overview

2.1 Function
WinPP101 is a test and simulation program for the telecontrol protocol IEC 60870-5-101. 
You can monitor the Messages of an existing link or simulate the Master or the substation. 
The program creates a process image, see Menu: "View > Process image". You can view the 
process image online and use it to filter.
Interfacing to the telecontrol equipment is done via the serial interface COM. The program 
supports two COM interfaces. It is possible to run the program several times simultaneously 
and thus support several COM interfaces. Do you want to monitor the command and 
monitoring direction simultaneously, you need two COM ports. For simulation a COM port is 
sufficient.
Additionally, it can listen and logically output ABB RP570 and RP571 telegrams. For test 
purposes it can also be used as a “Format 1.2” or as a “Byte” receiver, here the parity, 
number of data bit and stop bit are to be parameterised, see Parameterize Rec/Trans 1 > 
Function.

The program can be used without administrator rights.
Upon the first start, the program creates the "Data Directory" under "C:\MyDocuments\
Users\ User Data\ PPFink\ WinPP101\ and copies the "Log.lg1" and "SeTel.st1" files into the 
directory. The "Data Directory" is used for saving the log, send and configuration data.
You can change the directory with the menu „Parameterize | General | Data directory“.

You can parameterize the following for example:
Ø Program function (monitoring, master, station, byte receiver)
Ø Transmit messages
Ø Transmit lists
Ø Plaintext and color of the objects (CSV-file)
Ø Simulation of command responses
Ø Simulation answer of general interrogation
Ø Messages into csv files send, see help text: message parameterize > type.
Ø Cyclic transmission of an extern telegram, loading lists, command responses, see 

help text: options parameterize
Ø Structure of station address and of object address
Ø Length of link address and length of cause of transmission
Ø Transmission mode (balanced/unbalanced) 
Ø Use of the single control character E5
Ø COM Port, Baud rate
Ø Dial up modem commands

When storing or displaying messages you can filter them with respect to: 
Ø Message type, Cause of transmission, Quality descriptor
Ø Common address, Object address, Originator address
Ø Time, Message number (and others)

The program reads the plaintexts of the individual objects from a csv file, format: “Object 
address; Color code; Plaintext;”, see example file “ExText1.csv” in the program directory. 
Select your csv file in the "File | Object Texts Load" menu. The currently used file is indicated 
in the status bar. Don't use the file names "BspText1.csv" and "ExText1.csv". These files are 
overwritten during each installation.

The program checks the received messages for transmission errors, link faults and ASDU 
faults. Faulty messages are marked as such. Every transmitted and received message is 
allocated a time stamp and is stored in a Log file. 
As a rule, the program uses the ”Log.lg1“ log file. If the user activates the ”Use new log file 
every day ...“ option (see Parameterize > Options), a new log file will be created for each day 
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of the month. The number of the day (01 - 31) is indicated in the file name. During reception, 
the user can page up and down the messages saved in the log file and shown on screen. A 
message of 20 bytes takes up 50 bytes of Log file space. The log file can be printed or 
exported as a text file or csv file or log file.

Start options
With startup options you can modify the program start see online Help > Overview > Start 
Options.

The parameters used last (Baud, COM number, function, …)  are saved in the transmit 
message file and in the log file.
The Log file is organised as a circular buffer. When the file is full then the newest message 
overwrites the oldest message. You can prevent this by deleting (Ctrl+D) the old messages, 
before you start testing or increase the maximum size of the Log file or by filtering the 
messages via Filter. If you start the program several times the following log files are used: 
Log.lg1, Log2.lg1, Log3.lg1, etc.

The message colors may be modified in one of the following ways:
Ø Color of the receiver/transmitter (lowest priority)
Ø Color of the transmission cause (dialog or file ExText1.csv)
Ø Color of the ASDU type
Ø Color of the object address, refer to the ExText1.csv object text file.
Ø Color for messages with qualifier greater than zero (highest priority).

The transmitted messages are parameterized logically. There are 12 messages and 12 lists 
available, see Parameterize message or Parameterize list. In a list you can parameterize 
3000 objects. For the simulation of command responses 1000 objects are available. The 
transmission instigation for the messages and lists takes place via the operation Transmit or 
via an event. An event can be: reception of a particular type of message or successful 
establishment of a link. You can then send an interrogation command, answer a interrogation 
command automatically, send commands, simulate responses, transmit cyclic measured 
values or simulate an avalanche of messages.
For test purposes you can send illogical link and data messages. For examples: send NACK 
instead of ACK, do not toggle the FCB bit, use private ASDU, send the check character 
incorrectly, etc., see Simulate faults.
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2.2 Initial start

Place the Dongle onto the parallel (LPT) or USB interface and start the program. You choose 
the English or German user interface with the menu “Parametrieren | Sprache”. On starting 
the first time you should parameterize the following two dialogue fields:

General parameters
Length of link address
Originator address
Structure of station address (Common address)
Structure of object address

Parameterize Rec/Trans 1
Page 1
Function
Transmission procedure
Link address

Page 2
COM Port for Rec/Trans
Baud rate

Save the parameters each time by clicking "OK".
Choose the "On-line message display” (Menu: View).
Go On-line (Menu: Mode).
Please note the LEDs and the status bar at the bottom of the window.

If you receive the message "e.n.n.n Dongle missing/wrong" after entering the online mode 
then check please:

- Was the program installed with administrators’ right?
- Is the dongle USB present?
-

The error code e.n.n.n has the following meaning:
2, 1011 or 1034.n.n.n  Dongle not found.
1004, 1005 or 1006.n.n.n Device driver not installed.
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Depending on the parameterized function you connect the PC's COM Port with the 
telecontrol equipment following the plan below.

Monitoring wiring diagram

Simulation wiring diagram

With Simulation switched on the program causes a link to be established. When the partner 
station transmits you should see the received messages.

With the Menu View or the keypad shortcut “1 to 7” you can change the output format of the 
messages. The current output format is displayed in the heading. 

WinPP101 saves the current parameters, Log file and messages when you exit from the 
program.
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2.3 Operating Instructions

The usual Windows operations apply for program start, maximising, minimising and closing 
the program window. 

The program WinPP101 uses menus for setting values and operation. You call the on-line 
Help for any main menu and for the dialogue fields via the key "F1" (e.g. select the menu and 
press F1).

You can select menus and input fields with the mouse or keypad. Keypad selection takes 
place via the "Alt" key and a "Hotkey". "Hotkey" is the underlined character in the menu text 
(e.g. "F" in File Menu) or in the label of an input field. Some operating systems display the 
Hotkey in the menu text only after menu selection (Press the Alt key).

For commonly used commands (On-line, Off-line, Transmit Message) you can enable a 
"keypad shortcut”, see WinPP101 Options. A "keypad shortcut” is a key combination with 
which you execute a command directly. For example the key combination “Alt+F1” transmits 
the first message or “Ctrl+D” deletes the messages in the log file.

Please note that the key Alt activates the Menu selection (a Menu is optically 
highlighted/raised). If the Menu selection is activated then the shortcuts are deactivated. By 
pressing the Alt key once more you can deactivate the Menu selection again.

If you have selected a table then you are in Navigation mode. Select the desired field with 
the cursor keys. By a mouse click or by using the key F2 or by pressing "any key" you 
change to the edit mode. If the "any key" is a valid input then the character entered replaces 
the previous value. If the input is an invalid key then the current value is retained.

In dialogue windows you can select the next field with the keys "Tab" or "Enter" (Return) or 
select the previous field with "Shift+Tab". In a drop-down field you can make the list drop 
down via the key F4 or make a selection with the arrow keys Up/Down or the Spacebar.

In the dialogue windows usually the buttons "OK", "Cancel" and "Help" are displayed. "OK" 
saves the entered values and ends the input, "Cancel" ends the input without saving the 
values, "Help" calls the on-line Help for the current dialogue field. 

You can enter numbers as decimal or hexadecimal numbers, example: 100 or $64;
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2.4 Display Messages

The program displays either the "On-line messages” or the "Log messages”. The title bar 
displays the program name, the name of the send telegram file and the data directory. If the 
send telegram file is not in the data directory, the path of the send telegram file is also 
displayed. With the Menu Viewyou select the messages and the output format. The status 
bar (lowest line) displays the program status, the kind of displayed message, the status of 
the filters and the name of the Log file. The kind of message will also be displayed in the 
message header. With the Output filteryou can filter the On-line messages and the Log 
messages. The meanings of abbreviations can be found in the online help. Faulty messages 
are marked with an Error text. For the message time a millisecond timer is used which is 
always synchronised with the PC time at a change from offline to online. For a received 
message the message time gives the time of reception of the last byte of the message, for a 
transmitted message the time of starting transmission. With a right click you call the pop up 
menu.
After the time, the time difference to the previous telegram is displayed, eg: d = 0.035 s 
means: The current telegram was saved 35 ms after the previous telegram.

Display On-line messages
In the window of the "On-line Message Display” you can see the Status Table, the Header 
and the received and transmitted messages. The messages will be issued one below the 
other (scroll mode). The lower most is the newest message.

Online messages window
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The Status Table displays the most important parameters from receiver/transmitter 1 and 2, 
see also Parameterize Rec/Trans. The columns have the following meaning:

Text Description

Received Displays the number of received and saved messages since selection 
of on-line status.

Errors Displays the number of received and saved messages with errors since 
selection of on-line status.

Transmitted Displays the number of messages transmitted since selection of on-line 
status.

Errors Displays the number of repeatedly transmitted messages since 
selection of on-line status.

L-Rec Displays the Link status of the receiver.

OK Link status is correct
??? Link status is faulty.
- No simulation or COM port is not allocated.

L-Tr Displays the Link status of the transmitter.

OK Link status is correct
??? Link status is faulty.
- No simulation or COM port is not allocated.

COM Displays the parameterized COM port number.

- No COM port allocated.

Baud Displays the parameterized baud rate.

Function Displays the parameterized function.

Procedure Displays the parameterized transmission procedure.

The Header displays the kind of message, the filter function and the output format. The 
messages will be issued one below the other. The lower most is the newest message. If you 
wish to look at the messages received at your own speed, select “Display Log messages” via 
F9. The program continues to send/transmit in the background.

Display Log messages
In the “Log Message Display” window will be displayed: the Header, the date and the number 
of the first message and the number of messages. The output format can be selected via 
View.

With the cursor keys and the scroll bar you can page forwards and backwards. The cursor 
key Up/Down leafs one message back or forwards. The Page Up/Down keys move five 
messages backwards or forwards. If you press simultaneously the key Page up/down and 
the Key Shift, Control or Shift and Control then you move 50, 500 or 5000 messages 
backwards or forwards. The Home key displays the first (oldest) message. The End key 
displays the latest (newest) message. If the on-line reception overwrites the messages just 
being displayed, then the last message received will be displayed the next time that you leaf 
through the pages.
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2.5 Process Image
When the feature is turned on, the program builds a process image when monitoring or 
simulating. The function is switched on with the menu "View> Image" or via the context 
menu. The first click, the function turns on and displays the window. A second click or closing 
the window switches the function off again. It is stored in the image maximum 20,000 
objects.
The process image is useful for a quick overview of the state of the objects and to filter for an 
object in the log file. To filter for an object by clicking in the "No" column of the row. A second 
click in the same column and row switches the filter off again.
Each table row corresponds to an object. The objects are grouped by RTU address, Object 
address and type. The number in the "No." column is a sequential number, "time" is the last 
reception time, "RTU" is the RTU address, "last type" is the object type, "last value" is the last 
value of the object, "last cause" is the cause of transmission, "cyc, back, spon, req, IR, act, 
con, end, other" are counters of the causes of transmission: cyclic, background, spontan, 
requested, interrogated or requested counter, activation, confirmation or return information 
command, end of activation and all other causes.

The above example is an excerpt from a process image with 5123 objects.

"Copy" copies the objects in CSV format to the clipboard.
"Delete" will delete the objects data.
"AutoFit Column Width"   If selected, the columns will change when outputting for the longest 
text.
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3 Menus

3.1 File Menu

Use the File Menu to open, save and print the log file or load and save the message file.

Command Description

Log Delete Deletes all messages in the current log file.

Log Open or New Displays the dialogue field Open Log File, with which you can open a 
log file. If the File does not exist then a new log file will be created. 
Note: When you start the program several times you must use different 
Log files.

Log Save as Displays the dialogue field Save Log file, with which you can save the 
current log file under a specified name. The old log file will be further 
used.

Log Print / to text, log file Displays the dialogue field Print Log messages, with which 
you can print the messages from a Log file to a printer or save as ASCII 
text file or save as file in the Log format.

Transmit messages (Settings) Load Displays the dialogue field “Load transmit 
messages (Settings)”, with which an existing transmit messages file can 
be loaded. The transmit messages file consists of parameterized 
transmission messages, transmission lists, command responses and 
Settings (baud, function, link address …).

Transmit messages (Settings) Save as Displays the dialogue field “Save transmit 
messages (Settings)”, with which you can save the current transmission 
messages, transmission lists, command responses and Settings (baud, 
function, link address …).

Object Texts Load Displays the dialog box "Load object texts file", with which you select 
and load the desired CSV file, example file see "ExText1.csv".

Object Texts Clear Clears (deletes) the loaded object texts in the memory.

Object Texts Show Shows the loaded object texts.

Exit Saves the current program status, the current log file, message file and 
ends the program.
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3.1.1 Print Log messages (File | Log Printing)

With this dialogue field you parameterize the message output to a printer or into a text file. 
Note that the Output filter and the Output format are also apply to the printing.

Message Output 
Choose whether you want to output to a printer or to a text file or in a log file. The output 
destination automatically determines the file extension. The following assignment applies: 
output in log file = ".lg1", output in text file = ".txt", output in csv format in text file = ".csv".

Select Printer
This drop-down field displays the available printers. Select the desired printer.

Directory
Displays the directory used.

Name
Display the file name. By clicking on the file name you invoke the file selection dialog. Here 
you can change the name, change the directory or create a new folder. Select an existing file 
if you want to overwrite the file. The current log file, you can not overwrite it. The selected 
path and file name is stored and suggested the next time. The file name "Log" is 
automatically completed by the program by program number, date and file extension. 
Example: The file name "Log" is automatically expanded to "Log101_2014_05_01.txt".

Click "OK" or "Save" to start printing.

3.2 Mode Menu

Use the Mode Menu to switch the program between on-line and off-line mode and to call the 
dialogue field Link Test. "On-line" means that the program uses (opens) the parameterized 
serial interface and can receive and transmit data. Please also note the status bar.

Command Description

On-line The program receives/transmits data over the serial interface. 

Off-line The program releases (closes) the serial interface.

Link Test Rec/Trans 1 Displays the dialogue field Link Test Rec/Trans 1.

Link Test Rec/Trans 2 Displays the dialogue field Link Test Rec/Trans 2.
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3.3 Transmit Menu

Use the Transmit Menu to carry out the instigation of transmission for messages and lists. 
The program checks cyclically in the background whether a message or a list should be sent. 
The interrogation is in the order: message 1-12, list 1-12. The first message or first list found 
will be sent. After it is sent the interrogation begins again at message 1 that means that 
message 1 has the highest transmission priority. In the case of the program simulating the 
Master or Substation then transmission can only take place when the link was established 
successfully to the partner station. When monitoring you can always transmit per operation, 
the program does not wait for acknowledgement. The command "Stop cyclic transmission” 
stops the cyclic transmission of messages and of lists.

Command Description

Messages Displays the Messages submenu. Via the relevant Hotkey (1-9, A-C) or 
by clicking you start the transmission of a message. Between the 
Hotkey and the list designation there can be a code. The code is 
dependent on the parameter "Transmission instigated by...".

Code Meaning
No code Transmission instigated by operation.
* Message is ready to send.
tn Transmission instigated by reception of message of type 

n.
lt Transmission instigated by Link Transmitter ok.
lr Transmission instigated by Link Receiver ok.
mn Transmission instigated by Minute n.
cn Transmission instigated every n minutes (cyclic).

Lists Displays the transmission list submenu. Via the relevant Hotkey (1-9, A-
C) or by clicking you start the transmitting of a list. Between the Hotkey 
and the list designation there can be a code The code is dependent on 
the parameter "Transmission instigated by...", see Messages above.

Stop cyclic transmission Stops the cyclic transmission of all messages and lists. The 
simulation of the link level, the command responses and the command 
confirmation remain unchanged. The command is only active during 
cyclic transmission.
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3.4 View Menu

Use the View Menu to format the output and select the type of message (On-line, Log 
messages). The chosen output format will also be used in printing messages. With Output 
filter you can filter messages.

Commands Description

With time The messages will be displayed with or without the time. The messages 
in the Log file will be given a time stamp when received or sent. The PC 
system time will be used.

With Link The messages will be displayed with or without the link. If you have 
selected "Without Link" then the program stops displaying the link 
messages. They will however continue to be saved and counted.

Logical The message type and the transmission cause will be displayed in plain 
text. Each data messages will be displayed in four lines (without time, 
without link).

Compact The message type and the transmission cause will be displayed in a 
compact form. The texts of the message types are defined in the 
“Typ1Usa.csv” file. You can modify the texts in the file. Each data 
messages will be displayed in two lines (without time, without link).

Single line The data message will be displayed in one line. If the line is too long, 
select without time, without link or select a different output format. The 
texts of the message types are defined in the “Typ1Usa.csv” file. You 
can modify the texts in the file.

Byte ser. Hex. All bytes of a message will be displayed in hexadecimal. The order is 
the same as the received order.

Export (CSV) The message will be displayed in one line. All values are separated with 
semicolons (";"). Use this format when printing out to a file, if you want 
to load the messages into a spreadsheet. The values will be output in 
the following order: Message number, sub-number, message 
identification, date, time, milliseconds, message type, error text, link 
code, link address, type text, type number, structure, cause, source, 
station address, object address, plain text, data, qualifier, milliseconds, 
minutes, validity id, hour, summer time, day, month, year. The data is 
type dependent. For time only the values that exist will be displayed. 
The sub-number numbers the objects or the data within a message.

Log messages The messages of the log file are displayed. With cursor keys or the 
scroll bar you can leaf through the pages, see Display messages.

On-line messages The received and transmitted messages are displayed continuously. 
The bottom message is the newest message, see Display messages.

Process image This will display the process image. The first click turns on the image 
function and displays the image window, the second click turns off the 
function and closes the window.
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3.5 Parameterize Menu

Use the Parameterize Menu to parameterize the transmission messages, transmission lists, 
receiver/transmitter 1 or 2, general parameters and to set options.

Commands Description

Messages Displays the submenu Transmission messages. With the relevant 
Hotkey (1-9, A-C) or by clicking you call the dialogue field Parameterize 
message. Between the Hotkey and the list designation there can be a 
code. The code is dependent on the parameter "Transmission instigated 
by...".

Code meaning 
No code Transmission instigated by Operation.
* Message is ready to send.
tn Transmission instigated by reception of message of type 

n.
lt Transmission instigated by Link Transmitter ok.
lr Transmission instigated by Link Receiver ok.
mn Transmission instigated by Minute n.
cn Transmission instigated every n minutes (cyclic).

Lists Displays the submenu Transmission Lists. With the relevant Hotkey (1-
9, A-C) or by clicking you call the dialogue field parameterize list. 
Between the Hotkey and the list designation there can be a code. The 
code is dependent on the parameter "Transmission instigated by...", see 
Messages above.

Command responses Displays the dialogue field Parameterize command response
with which you can allocate/classify the command responses.

Language Displays the language selection submenu.

Font size, Message colors Displays the “Font size, Message colors“ dialog window. The 
font size and the message output colors can be specified via this 
window.

Color of the ASDU types Displays the Color of the ASDU types dialog window.

Color of the transmission causes Displays the Color of the transmission causes dialog 
window.

Receiver/transmitter 1/2 Displays the dialogue field Parameterize receiver/transmitter, 
with which you can parameterize the program function, link address, 
COM number, Baud rate etc.

General Displays the dialogue field General parameters, with which you can 
parameterize the Message and File transfer parameters and the size of 
the Log file. These parameters are valid for receivers/transmitters 1 and 
2.

Options Displays the dialogue field WinPP101 Options, with which you activate 
various functions.

Dial up modem Displays the dialogue field Dial up modem, with which you specify and 
send modem commands (AT commands).
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3.6 Filter Menu

Use the Filter Menu for filtering the message output to the monitor screen and printer and to 
switch the output filter on or off. With the Log Filter you can filter the messages saved to the 
Log file.

Commands Description

Output filter Displays the dialogue field Parameterize Output Filter, with which you 
can change the form of the output of messages on the screen.

Output filter off/on Switches the output filter off or on (if you have parameterized the output 
filter). You can thus deactivate the filter function without 
reparameterizing the output filter.

Log filter Displays the dialogue field Parameterize Log Filter, with which you can 
parameterize the filter for saving messages to the log file. Note that only 
the saved messages will be On-line displayed.

3.7 Help Menu

Use the Help Menu to start the On-line Help or to display the program version number.

WinPP101 Help Starts the On-line Help.

Info Displays the program version number.
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4 Parameters

4.1 General parameters (Parameterize | General)

With this dialogue field you parameterize the message parameters, the file transfer 
parameters and the size of the Log file. The parameters are valid for receiver/transmitter 1 
and 2.

Length of link address
Enter the length of the link address in bytes.

Originator address
The parameter specifies the length of the transmission cause. If the originator address exists 
then the cause of transmission consists of two bytes, otherwise it has only one byte.

Structure of station address
Here you define the length and structure of the station address in bits. The station address 
can be 8 or 16 bits long (1 or 2 bytes). If the address is structured then give the length in bits 
for each field, from high to low, up to 5 fields. The sum must be 8 or 16. The station address 
is also called "Common address of ASDU" or "Common address".
Example 1: The address is 1 bytes long and unstructured. Enter: 8 
Example 2: The address is 2 bytes long and structured, the highest value field is 4 bits long, 
the least value field is 12 bits long. Enter: 4 12 

Structure of object address
Here you define the length and structure of the object address in bits. The object address 
can be 8, 16 or 24 bits long (1, 2 or 3 bytes). If the address is structured give the length in 
bits for each field, from high to low, for up to 5 fields. The sum must be 8, 16 or 24. The 
object address is also called "Address of the information object".
Example 1: The address is two bytes long and unstructured. Enter: 16 
Example 2: The address is three bytes long and structured (12 bits field number, 8 bits 
element number, 4 bits current number). Enter: 12 8 4  

Value normalized for 100%
Normalized measured values and set points will be displayed as a decimal number and as a 
percentage. The percentage value is calculated using the parameterized value.

File addressing by
The parameter specifies for File Transfer Simulation whether the file will be addressed by the 
file name or by the object address.

Time-out [s]
The parameter specifies the monitoring time for file transfer. The message "File ready" 
(F_FR_NA_1) starts the monitoring. The message "File confirmation" (F_AF_NA_1) ends the 
monitoring. During the monitoring, every file transfer message reloads the monitoring time. 
When the monitoring time runs out, then the file transfer simulation is stopped.

Select first file 
If you have parameterized "automatically" then the program sends the message "File select" 
(F_SC_NA_1) for the first file in the file directory after receiving the message "File directory".
The message will be sent after receiving the last directory messages (LFD = 1), at the most 
10 seconds later.
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Idx file:
The parameter specifies whether the program uses an index file during transmission or 
creates one when receiving. The index file has the same name as the data file but the 
extension 'IDX'. The Index file is an ASCII text file in which the section lengths are stored (1-
16777215). Every section has a line; each line ends with the control characters carriage 
return and linefeed (13, 10). 

Example: The data file '123' is 13111 bytes long and will be transmitted in four sections with 
the lengths 12, 12000, 999 and 100.

File name: 123.IDX
Line 1: 12
Line 2: 12000
Line 3: 999
Line 4: 100

Max. size of Log file [MB]
The parameter specifies the size of the Log file in million bytes. There must be enough free 
space on the hard disk.

Data Directory
The program saves the log file, the transmit telegram file, the csv files of the lists, the csv file 
of the command response information, the filter file and the configuration data to the 
specified directory. A data directory change causes the following: The current files are 
closed, the current configuration is saved, the directory is changed, the new configuration is 
loaded, the default log file is loaded and the last used (in the new directory) files are loaded. 
At program end the data directory is stored in the registry. Key: 
HKEY_CURRENT_USER\Software\PPFink\WinPP104

Summer time flag in transm. lists, command responses
If messages with time are transmitted in the transmission lists or with the “Simulation of 
command responses “, this parameter determines whether the ”Summer time bit“ is set in the 
message.

Substituted time flag in transm. lists, command responses
If messages with time are transmitted in the transmission lists or with the “Simulation of 
command responses “, this parameter determines whether the ”Substituted time bit“ is set in 
the message.
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4.2 Font size, Message colors (Parameterize | Font size, Message colors)

In this dialog window, you can specify the font size and the message output colors. The left 
box displays examples of the selected colors.
Colors are assigned in the following priority:
-Color of the receiver/transmitter (lowest priority)
-Color of the transmission cause
-Color of the ASDU type
-Color of the object address, refer to the ExText4.csv object text file.
-Color of messages with qualifier greater than zero (highest priority).
The assignment of the colors is stored in the "W101.cfg" file.

Font size
Select the desired font size.

Blank lines between the messages in per cent
You may enter values between 0 and 200 %. Zero means no blank line, 200 means two 
blank lines.

R1 Receiver1
Select the text color and the background color for Receiver1.

T1 Transmitter1
Select the text color and the background color for Transmitter1.

R2 Receiver2
Select the text color and the background color for Receiver2.

T2 Transmitter2
Select the text color and the background color for Transmitter2.

Heading
Select the text color and the background color for the heading. The background color of the 
message output window is cleared by the background color of the heading.

Error message
Select the text color and the background color for the error messages.

Program message
Select the text color and the background color for the program messages.

Qualifier > 0
Select the text color and the background color for the messages with qualifier bit greater than 
zero.

IV   NT   SB   BL   EI   OV   IV time   SB time
Here you can select the qualifier bit to be checked. IV time = IV bit of time,
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4.3 Color of the ASDU types (Parameterize | Color of the ASDU types)

The message color to be used for an individual ASDU type is specified in this dialog box. 
Select the type and then select the text color and/or background color. The selected color are 
displayed as an example in the type list.
Colors are assigned in the following priority:
-Color of the receiver/transmitter (lowest priority)
-Color of the transmission cause
-Color of the ASDU type
-Color of the object address, refer to the ExText4.csv object text file.
-Color of messages with qualifier greater than zero (highest priority).
The assignments "Color per type/transmission cause" are saved in the "W101.cfg" file and in 
the telegram file (e. g. SeTel.st1).

ASDU types
Select the desired type.

Text color
Select the desired color. The selected color is indicated in the type list.

Background
Select the desired color. The selected color is indicated in the type list.

4.4 Color of the transmission causes (Parameterize | Color of the transmission 
causes)

The message color to be used for an individual cause of transmission is specified in this 
dialog box. The cause must be selected first and the text color and/or background color 
afterwards. The selected color are displayed as example in the cause list.
If a private transmission cause is assigned a specific color, the message concerned is no 
longer output as an error with the "Transmis. cause false" ID, but as a usual message with 
the " User cause of transm." ID.
Colors are assigned in the following priority:
-Color of the receiver/transmitter (lowest priority)
-Color of the transmission cause
-Color of the ASDU type
-Color of the object address, refer to the ExText4.csv object text file.
-Color of messages with qualifier greater than zero (highest priority).
The assignment of a specific color for each cause is stored in the "W101.cfg" file.

Causes
Select the desired cause of transmission. The list also indicates causes with the "test" and 
"negative confirm" IDs.

Text color
Select the desired color. The selected color is indicated in the cause of transmission list.

Background
Select the desired color. The selected color is indicated in the cause of transmission list.
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4.5 Parameterize Rec/Trans 1/2 (Parameterize | receiver/transmitter 1/2)

With this dialogue field you parameterize the parameters specific to protocol and interface 
e.g.: function, COM number, Baud etc.). The dialogue field consists of the following pages.

Page 1 Here you find the parameters specific to the protocol.

Page 2 Here you find the parameters specific to the interface.

With the keys "Ctrl+Tab" you can toggle between the pages.

Page 1

Function
With this parameter you specify the program function. The selected function is only possible 
in on-line Mode, see Mode.

Monitoring: You can monitor messages on an existing link. The received messages are 
checked for logical correctness. If your PC has two COM interfaces, you can monitor the 
command and monitoring directions simultaneously. You only use the receiver of COM 
interface. The program does not send any messages itself. You can transmit messages via 
operation.

Master/Substation (balanced): In mode On-line the program establishes a link to the 
partner station. Messages received are acknowledged and possibly cause the transmission 
of messages or message lists. You can send messages or lists. The program waits for and 
checks the acknowledgement. 

Master (unbalanced): In mode On-line the program establishes a link to the substation and 
sends cyclic polling messages. You can send messages/lists. The data messages will be 
inserted into the polling cycle.

Substation (unbalanced): In mode On-line the received messages with 'correct' link 
address are processed logically. Polling messages are acknowledged with 'Interrogated data 
not available'. If a message or a transmission list is active then the data message will be 
sent. A message or a list is activated via an operation or through an event, see 
Parameterize message.

Format 1.2: This function is useful for receiving messages which are framed according to 
IEC 60870-5-1, Format 1.2, but whose user data do not comply with IEC 60870-5-101. The 
program does not check the link layer or the user data. Messages with fix or variable length 
and the single characters E5 and A2 are permissible. The bytes of the messages are 
displayed as decimal values (Logical), as bit pattern (Compact), as hexadecimal values one-
line (Single line) or as hexadecimal values (Byte ser. Hex). Only a few 101 parameters are 
effective. The parity, the number of data bits per byte and the number of stop bits can be 
parameterised. The "Length of Link Address" parameter determines the length of the link 
messages.

Byte receiver: The program receives and transmits byte sequences. All "IEC -101" 
parameters are irrelevant. The parity, number of data bits per byte and the number of stop 
bits are to be parameterised. The output format is the same as “Format 1.2”. The maximum 
length or a pause longer than “Idle end of receive message:…” ends the receive message. 
You parameterise the maximum length and the Idle of the receive message on page 2. If the 
program does not recognise short pauses, set receive buffer and transmit buffer to 1 or 
switch off the use of the "FIFO buffer“ via the Device Manager, see below „Leading time 
RTS“.

http://www.ppfink.de


Operating instructions WinPP101 April 2015

Reinhard Fink Ingenieurbuero www.ppfink.de Page 22

Monitor RP570: The program expects ABB RP570 telegrams and outputs them logically.

Monitor RP571: The program expects ABB RP571 telegrams and outputs them logically.

Transmission mode
Balanced means spontaneous operation (End-End), unbalanced means polling operation 
(Polling, Multipoint partyline).

Link address
If link addresses are used (i.e. the length of the link address is greater than zero, see 
General Parameters), you can parameterize one or several link addresses. The link address 
will be checked during transmission and reception but not by monitoring. In balanced 
operation (End-End) only one link address is sensible. In unbalanced operation (polling 
operation) you can define up to 8 addresses. If the program is simulating the Master then it 
calls the parameterized addresses one after the other. If the program is simulating the 
Substation, then it processes the received messages only on address identity.

Cycle time link test
This parameter specifies the cycle time with which the message "Test link status" will be 
sent. Zero means, "Send no cycle test”. Each acknowledgement received without errors 
resets the cycle time clock, i.e. the message will only be sent if no acknowledgement is 
received within the cycle time.

Cycle time Polling
In the unbalanced mode, the parameter determines the cycle time of the substation call. If 
you set the parameter to zero, the call is executed as soon as possible.

Direction bit
The parameterized value will be used in balanced operation during transmission. In 
unbalanced operation this parameter has no meaning.

Use of single character E5
With this parameter you define whether the single character "E5" is allowed as positive 
acknowledgement. You can set it to be used with Receive and Transmit (Rec+Trans) or only 
for Receive (only Rec). The selection "Pos. Ack. + no data" is only sensible in unbalanced 
operation and means: Use “E5” as positive acknowledgement, and accept and send “E5” in 
the place of the link message 9 (Interrogated data not available).

Type of cyclic RTU polling 
Only possible in unbalanced operation and during simulation of the Master station. The 
parameter specifies whether the data class 2 (Standard) or 1 will be polled during cyclic RTU 
polling.

Command messages
The parameter specifies whether the program automatically confirms command messages 
with the transmission cause "Activation". Command messages are: Commands, General 
interrogation, Check/Test command, Parameter, etc. (all "CON" messages).

Spikes before/after the message
The parameter determines if spike telegrams shall be displayed and stored. For half-duplex 
connections or during line operation, pulses may occur on the receive side while the 
modulation is switched ON and OFF. These pulses are received as bytes. A spike message 
occurs if the message id is faulty, if the message length is smaller than five bytes and if 
maximally two spike messages occur after an error-free message.
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Display changes of:  DCD  DSR  CTS
If desired the program stores the changes in level of the lines together with the time, in the 
log file. The time measured is most exact when you have not parameterised a transmission 
delay i.e. "Delay in transmitting: 0" and "Function RTS Signal: always 1 or 0". The lines are 
assigned to the following pins on the 9-pole COM plug:
Pin Line Meaning
1 DCD Data Carrier Detect
6 DSR Data Set Ready
8 CTS Clear To Send

Page 2 

Log file comment
Upon each offline/online change, the program writes this text into the log file.

COM Port for Rec/Trans
The parameter specifies which COM port should be used. At the start of the program the 
program determines the existing COM ports. The COM port used must not be in use by 
another program.
Using WinPP101 in a terminal server client session new USB COM ports are only available 
after restarting your client session.

Baud, Parity, Data
These parameters specify the transmission rate, the parity, the number of data bits per byte 
and the number of stop bits. Conforming to the IEC 870-5-101 standard, the program sets 
the byte parity to even, sets the number of data bits to 8 and the number of stop bits to 1. If 
you have parameterized "Byte receiver" for the function or if you activate with the menu 
“Parameterize | Options | Parity… parameterizable”, you can determine the parity, data bits 
and stop bits.

Max. length of transmitted message
When transmitting a transmission list, several objects are sent in one message if possible (up 
to the maximum message length). This parameter only exists when the “Function: ...” (see 
page 1) is not equal to Byte receiver.

Max. Length of Receive Message
This parameter only exists when you have parameterised "Function: Byte receiver“ (see 
page 1).

Wait time for acknowledgement
This parameter specifies how long the program waits for the acknowledgement. The wait 
time is dependent on the baud rate and the maximum message length. The program 
recommends the standard value. You can change the recommended value. This parameter 
only exists when the “Function: ...” (see page 1) is not equal to Byte receiver.

Idle end of Receive Message
An idle time greater than parameterized ended the receive message. This parameter only 
exists when you have parameterised "Function: Byte receiver“ (see page 1).
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Number of transmission repetitions
If the acknowledgement does not arrive within the "Wait time for acknowledgement" then the 
program repeats the transmission  n  times (n equals the parameter value). At the end of the 
transmission repetitions, the program throws the transmitted message away, reports the 
transmitter direction as being faulty and sends the "Interrogation Link status" cyclically. 

Cycle time of link status interrogation
This parameter specifies the cycle time with which the link status of the partner station will be 
interrogated in the case of a faulty line.

Transmission delay by
Normally this parameter is zero. A value greater than zero delays the transmission of all 
messages. So you can delay the reply time. In semi-duplex mode you can wait till the partner 
station releases the modem.

Function RTS Signal
Necessary for semi-duplex (two wire) or multipoint-party line mode operation. RTS (request 
to send) informs the modem of the wish to transmit. For duplex operation set the parameter 
to "always 0" or "always 1".

Leading time RTS
Necessary for semi-duplex or multipoint-party line mode operation. Only possible if you have 
parameterized "Function RTS Signal: 0/1 during transmission". The leading time will be 
specified by the initial transient behaviour of the transmission route. The parameter specifies 
how long the program waits till it starts the transmission after the switching on of RTS. For 
duplex operation set the parameter to zero. Be warned that the times are not precise 
(within  +- 50 ms). Note: If the baud rate is less than 9600 you can improve this precision by 
setting the receive buffer and the transmit buffer to 1 of the FIFO or by switching of the use of 
the FIFO buffer for the COM port. You parameterize the use of the FIFO buffer as follows: 
Start | Settings | Control Panel | System | (Hardware Profile (NT)) | Device manager | 
COM n | Properties | Interface Settings | Advanced | Use FIFO. Sometimes the system 
must be restarted for this change to take effect.

Trailing time RTS
Necessary for semi-duplex or multipoint-party line mode operation. Only possible if you have 
parameterized "Function RTS-Signal: 0/1 during transmission". The trailing time will be 
specified by the final transient behaviour of the transmissions route. The parameter specifies 
how long the program waits after transmission till it switches RTS off again, see also 
“Leading time RTS”. Necessary for semi-duplex or multipoint-party line mode operation. Only 
possible if you have parameterized "Function RTS-Signal: 0/1 during transmission". The 
trailing time will be specified by the final transient behaviour of the transmissions route. The 
parameter specifies how long the program waits after transmission till it switches RTS off 
again, see also leading time RTS.
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4.6 Parameterize message (Parameterize | messages | 1-9, A-C)

Key combinations (if parameterized):  "Shift+F1-12"

With this dialogue field you parameterize messages that you want to send. The transmission 
instigation takes places via operation or an event (e.g.: links establishment or receipt of a 
message). A click on "Transmission” saves and sends the list without closing the dialogue 
field. The parameter "Message send how often...” is also valid here.

Right-click outside the input field to call up a pop-up menu. In the pop-up menu, you can 
save the message in a csv file or load it from a csv file. 
Note: You can leave this dialogue field during parameterizing. But you can’t open this 
Dialogue field twice simultaneously. 

Message designation
You can allocate a logical designation to the message. This designation will be displayed in 
the Message Menu.

Transmission instigated by
You can choose whether the message can only transmitted by an operator entry or also by 
an event. An event can be: Receipt of a specific message (the message type can be 
parameterized), Link establishment in transmission or reception direction or a time (the 
minute can be parameterized). On “Transmission instigation by Type n” the received 
common address must be equal the parameterized common address.

Type n
If the transmission should be "Transmission instigated by: type n” enter the type number 
here. In all other cases, this parameter has no meaning. The fictive type 256 means instigate 
by any type, the fictive types 257-272 means instigate by a link message with function code 
0-15. The instigation by type 256-272 also runs in monitoring mode and in Byte receiver 
mode.

Minute
If the transmission should be "Transmission instigated by: Time" specify the minute or the 
cycle time in minutes.

Msg. to be sent how often
This parameter specifies how often the message is to be sent after a transmission 
instigation. The value zero means cyclic transmission.

Transmitter
With this parameter you specify which transmitter the message will be sent by.

Wait time after transmission
The parameter specifies for multiple transmissions, how long the pauses are between the 
messages.
Example: You want to transmit the message 10 times at intervals of 2 seconds. 
Parameterize: "message send how often: 10" and "Wait time after transmission: 2000".

Transmission procedure
In the transmission mode balanced or on simulation master unbalanced the following 
procedures are possible: "Send/Confirm" (the receiving station must confirm the message) or 
"Send/No Reply" (the receiving station does not confirm the message).

Data class
During the simulation of the substation in the unbalanced mode, you can specify if the 
message belongs to data class 1 or 2. Data class 1 or 2 is requested with the message 
“request user data class 1 or 2”.
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Link address
This parameter only exists when the transmission procedure is unbalanced and you have
parameterized more than one link address in Receiver/transmitter parameterize. In all 
other cases, the program automatically uses the first parameterized link address.

Type
For standard messages select an IEC message type. For private messages or for illogical 
messages select “ASDU as Hex-String”, “Link as Hex-String”, “Link and ASDU as Hex-
String” or “Message as Hex String/Text String". For "ASDU or Link as Hex String" the 
program packs the sequence of bytes to conform to the standard (Start character, length, 
test character and stop character). By "message as Hex String/Text String" the program 
sends the sequence of bytes unchanged. You can thus simulate faulty messages; see 
Simulate faults. If an IEC type was parameterized before selection of "... as Hex String" 
then this message will be output as a template. You can then change individual bytes in 
order to transmit faulty messages.
With the type "Messages in csv file" you may send messages which are stored in a csv file. 
The file includes one ASDU (= message) per line and one value for each byte. This allows 
you to send any messages. The following example shows a GI response with a double-point 
information and a measured value, length of common address 2 bytes, object address 3 
bytes; an originator address does not exist.
100;1;7;1;2;0;0;0;20;
3;1;20;1;2;1;2;3;2;
11;1;20;1;2;2;2;3;0;1;0;
100;1;10;1;2;0;0;0;20;
With the "Messages in csv file" type, the "Msg. to be sent how often" parameter is of no 
relevance. As soon as the transmission has been activated, all telegrams are transmitted at 
once.

Cause
The causes are Type dependent. Only the causes allowed are available for selection.

Originator address
Only exists when you have parameterized the originator address as exist in the dialogue field 
General parameters.

Station address
You can enter the address in decimal or hexadecimal, Example: 123 or $7b. If the Station 
address is structured separate the individual values with blank or minus characters, 
Example: 12 3  or $c 3  or 12-3.

Object address
You can enter the address in decimal or hexadecimal, Example: 123 or $7b If the Object 
address is structured separate the individual values with blank or minus characters, 
Example: 12 3  or $c 3  or 12-3.
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1 Information status
The parameter text and value are Type dependent, see status bar (last line in window). If you 
enter a hex string then the following characters are allowed: 0-9, A-F and blanks. Each byte 
consists of a maximum of two characters. The bytes can be separated by blanks. Example: 
The input:  1 2 0 78abc  results in  6 bytes with the values: 01 02 00 78 ab 0c.

2 Qualifier
The qualifiers are type dependent, it can be that none exist for a particular type.

3 Time (hh.mm.ss, Millisecond) IV SB
The time is type dependent. It can be that no time field exists for a particular type. For types 
with short time (minutes, seconds, millisecs) the hour field is not used. If you do not 
parameterize time then the current PC system time will be used at transmission. 
IV (Invalid) = 0 = time is valid, IV = 1 = time is invalid
SB (Substituted) = 0 genuine time, 1 = substituted time.

4 Date
The date is type dependent. It can be that none exists for a particular type. If you do not 
parameterize date then the current PC system date will be used at transmission.
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4.7 Parameterize Lists (Parameterize | lists | 1-9, A-C)

Key combinations (if parameterized):  "Strg+Shift+F1-12"

With this dialogue field you parameterize messages that you wish to transmit. If you want to 
configure several common addresses in a list, you must enable the option "Several common 
addresses per transmit list". The transmission instigation takes places via operation or an 
event (e.g.: links establishment or receipt of a message). A click on "Transmission” saves 
and sends the list without closing the dialogue field. The parameter "List/objects send how 
often...” and "Number of objects per transmission...” are also valid here. The transmission 
begins with the active object in the list. Afterwards the active object is pushed back the 
number of places equal to "number of objects per transmission...”.

You can copy objects in a list into the Clipboard or cut and paste from the Clipboard. Here 
select the spreadsheet/table and use the right hand mouse button pop-up menu or with 
Shift+F10. Before copying/cutting you must select the objects (you can use Shift+cursor keys 
or Shift+mouse click), at least two fields must be marked. In a list a maximum of 3000 objects 
are stored.
If more than 3000 objects are stored in the csv file, the program asks when loading the file if 
you want to save the remainder of the objects in the follow list (list no. + 1).
When the last object is parameterized when saving the transmission list, the program asks 
whether the following list (list number + 1) to be saved.
In the csv file, the following values are stored in the first line: Name, transmission instigation, 
kick message type, how often send, sender number, objects per sending, waiting time, 
transfer procedure, link address, virtual type, virtual cause, source address, station address, 
virtual object address, virtual information, virtual quality identifier. The virtual values are in the 
list meaningless, they are only placeholders, they are used in the telegrams. In the following 
lines the objects 1, 2, etc. are stored. In an object line, the values are: Active, common 
address, object address, type, cause, information, origin, qualifier stored. The values of 
common address and origin are only used if you have enabled the option "Multiple station 
addresses per send list", see Paranetrieren> Options.
You can load or copy messages from the log file in the list. Upload the log messages as 
follows: Filter the desired messages, select the output format "export (csv)", select "Print 
Log" in text file and save the file. Call a program edit, make a right-click outside of an input 
field, select "list of csv file" Load and choose the saved csv file. To copy the messages from 
the log file in the list, save the messages in the export format in a text file. With a text editor, 
such as Notepad, load the text file, select and copy the desired messages to the clipboard. 
Select the required list, select the insertion point and paste the telegrams with the pop-up 
menu or "Ctrl + V".
Note: You can leave this dialogue field during parameterizing. But you can’t open this 
Dialogue field twice simultaneously.

Designation
You can allocate a logical designation to the message. This designation will be displayed in 
the Lists Menu.

Transmission instigation by
You can choose whether the message can only transmitted by an operator entry or also by 
an event. An event can be: Receipt of a specific message (the message type can be 
parameterized), link establishment in transmission or reception direction or a time (the 
minute can be parameterized). On “Transmission instigation by Type n” the received 
common address must be equal the parameterized common address.

Type n
If the transmission should be "Transmission instigated by: type n" enter the type number 
here. In all other cases, this parameter has no meaning. The fictive type 256 means instigate 
by any type, the fictive types 257-272 means instigate by a link message with function code 
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0-15. The instigation by type 256-272 also runs in monitoring mode and in Byte receiver 
mode.

Minute
If the transmission should be "Transmission instigated by: Time" specify the minute or the 
cycle time in minutes.

List/objects send how often
This parameter specifies how often the list or the number objects per Transmission is to 
be sent after a transmission instigation. The value zero means cyclic transmission.

Number objects per transmission
The parameter specifies how many objects will be sent after a Transmission instigated. The 
value zero means all objects in the list. The objects will be transmitted in one or more 
messages without any wait time.

Wait time after transmission
The parameter specifies the transmission cycle time for multiple transmissions. After 
transmitting the number objects per transmission the program waits the specified time till it 
transmits again.

Example 1: You wish to transmit ten commands at intervals of 5 seconds.
You parameterize:

list/objects send how often: 10, 
number of objects per transmission: 1, 
Wait time after transmission: 5000
and ten commands in a list. 

Start via Transmission| lists | 1-9, A-C. If you want to start each command per operation 
then parameterize as follows: 

list/objects send how often: 1, all other parameter remain unchanged. 
The parameter Wait time after Transmission is meaningless here because there is only 
one transmission per instigation.

Example 2: If you want to transmit 5 objects after receipt of a general interrogation.
Then parameterize:

Transmission instigated by : Operation./type n
type n: 100
list/objects send how often: 1
number of objects per transmission: 0

and in the object table:
the confirmation of the activation
the five objects and 
the stopping of the activation.

Transmission procedure
In the transmission mode balanced or on simulation master unbalanced the following 
procedures are possible: "Send/Confirm" (the receiving station must confirm the message) or 
"Send/No Reply" (the receiving station does not confirm the message).

Data class
During the simulation of the substation in the unbalanced mode, you can specify if the 
message belongs to data class 1 or 2. Data class 1 or 2 is requested with the message 
“request user data class 1 or 2”.

Link address
This parameter only exists when the transmission mode is unbalanced and you have 
parameterized more than one link address in Parameterize receiver/transmitter. In all other 
cases, the program automatically uses the first parameterized link address.
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Originator address
Only exists if you parameterized the originator address as exists in the dialogue field 
General parameters.

Station address
You can enter the address in decimal or hexadecimal, Example: 123 or $7b. If the Station 
address is structured separate the individual values with blank or minus characters, 
Example: 12 3  or $c 3  or 12-3.

Parameterize the object table
After selection of the spreadsheet/table (with mouse click or Tab key) you will find yourself in 
Navigation mode. With the cursor keys you can select a particular field. By clicking or use of 
the function key F2 or any key you return to edit mode. Any valid key overwrites the old 
value, an invalid key retains the old value. With Enter or Tab you leave the input field. You 
can copy the objects in a list with pop-up menu or the keypad combinations into the 
Clipboard, cut and paste from the Clipboard. Before copying/cutting you must select the 
objects (you can use Shift+cursor keys or Shift+mouse click), at least two fields must be 
marked. The program always copies complete objects. 
Example 1: You have parameterized 5 objects (1-5) and want to copy the objects 3-5 to 
object 6-8. 

Select the active column of object 3. Hold the shift-key down and press the down arrow key 
twice (The active column of object 3, 4 and 5 is marked). Press the right hand mouse button 
to call the pop-up menu. Select Copy. Then select with the cursor keys the active column of 
object 6. With the command Insert from the pop-up Menu insert the three objects at object 6.

Example 2: You want to delete object 5. 
Select the active column of object 5. Hold the shift-key down and press the Right arrow key 
once the (Active and object address are marked). Release the shift key. Using “Ctrl+X” 
delete the object 5. The following objects will be moved upwards. The deleted object has 
been put into the Clipboard

Active
Only the marked objects will be transmitted.

Object address
You can enter the address in decimal or hexadecimal, Example: 123 or $7b. If the object 
address is structured separate the individual values with blank or minus characters, 
Example: 12 3 or $c 3 or 12-3. With a right click you invoke a selection list.
The width of the column can be modified. Drag the left side of the window to the left or to the 
right with the mouse.

Type
Input a valid type number or press the function key F12 or right click for the selection list.

Cause
Input a valid cause number or press the function key F12 or right click for the selection list. 
The cause is type dependent. Only the causes allowed are available for selection.

Information
The information is type dependent. Enter the desired value as a decimal number, 
hexadecimal number ($nn)  or as bit string (.I). Note the status bar with the valid ranges.  

Qualifier 
The qualifier is type dependent. Enter the desired value as a decimal number, hexadecimal 
number ($nn)  or as bit string (.I). Note the status bar with the valid ranges.
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4.8 Parameterize Command Responses (Parameterize | Command responses)

With this dialogue field you activate and parameterize the command responses. The 
message types 45 to 51 are commands.

You can copy objects of the table into the Clipboard or cut and paste from the Clipboard.
Here select the spreadsheet/table and use the right hand mouse button pop-up menu or with 
Shift+F10. Before copying/cutting you must select the objects (you can use Shift+cursor keys 
or Shift+mouse click), at least two fields must be marked.

Simulation on/off
With this parameter you switch the simulation on and off. When simulation is switched on the 
program searches for the common address and the object address and the command 
qualifier of the received command in the spreadsheet/table. If the program finds the 
addresses then it sends the parameterized reply messages. If the program does not find the 
addresses then it sends the 'Negative confirmation of activation'. The program searches 
through the whole spreadsheet/table. You can also parameterize the same address several 
times (several responses after sending a command).
The functions "Simulation command responses" and "Command messages: Confirm" or 
"Transmission instigated by type n" can be active simultaneously.

Delay time return information
A value greater than zero delays the transmission of return information and the “activation 
termination”.

Parameterize the spreadsheet/table
After selection of the spreadsheet/table (via click or Tab key) you find yourself in Navigation 
mode. With the cursor keys you can select any field. By clicking or via the function key F2 or 
any key you enter the edit mode. A valid key overwrites the old values, an invalid key not. Via 
the Enter or Tab key you leave the input field. 

Station
Specify the station address which should be replied to. The station address will also be for 
the response.

Object address
Specify the object address which should be replied to. 

QU
Specify the qualifier of command which should be replied to, the joker is -1.

Con
If this parameter is marked then the 'Confirm the activation' will be sent (Con = Confirmation).

Ret
If this parameter is marked then the parameterized command response will be sent (Ret = 
return information = Response). This parameter is meaningless for selection commands.

Term
If this parameter is marked then the 'Stop the activation' will be sent (Term = Termination). 
The parameter is meaningless for selection commands.

R object address
This parameter specifies the object address of the command response.

R type
This parameter specifies the message type of the command response. Only the types 1-14 
and 30-36 are allowed. If the response type matches the command type (singe, double 
message singe, double command or measured value standardised to target value 
standardised, etc.), then the received information will be send back, otherwise the 
information section equals zero.
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4.9 WinPP101 Options (Parameterize | Options)

With this dialogue field you enable the key combinations and allow the Link Test.

Use  'F8'  to toggle between On-line/Off-line
Here enable the function key F8.

Use  ‘F9 or Cursor up/Esc’  to toggle Log/Online Display
Here enable the function key F9.

Use  'F11'  to switch Output filter off and on
Here enable the function key F11. Only if you have parameterized the Output filter, you can 
switch the Filter off and on.

Use  'F12'  to call up Output filter
Here enable the function key F12. You can then use F12 to start the dialogue field 
Parameterize Output filter.

Use  'Shift+Fn'  to parameterize message n
Here enable the key combination Shift+Fn (n = 1-12). You can then use Shift+Fn to start the 
dialogue field Parameterize message n.

Use  'Alt+Fn' to transmit message n
Here enable the key combination Alt+Fn (n = 1-12). You can then use Alt+Fn to transmit the  
message n.

Use  'Strg+Shift+Fn'  to parameterize list n
Here enable the key combination Ctrl+Shift+Fn (n = 1-12). You can then use Ctrl+Shift+Fn to 
start the dialogue field Parameterize list n.

Use  'Strg+Fn'  to transmit list n
Here enable the key combination Ctrl+Fn (n = 1-12). You can then use Strg+Fn to transmit 
the list n.

Several common addresses per transmit list
When enabled, the common address and the originator address can be specified in the 
transmission list for each object.

Parity, number of data bits parameterizable
Here enable the function “Parity, number of data bits parameterizable” for the COM port. 
That’s useful for connections which don’t use a parity.

Increase integrated totals by 15, sequence no by 1
On request, the program increases the integrated totals by 15 before the transmission 
(message type 15, 16 and 37). The sequence number is increased by one.

Cyclic transmission of an external telegram, loading external lists, command 
responses
With this function, an external program (eg Excel) can send messages or load lists and 
command responses automatically. The file structure corresponds to the format that is used 
for storing the telegrams and the lists and the command responses to a csv file (right-click in 
parameter window). If this option is enabled, the program checks, if online, every second the 
following:

Ø Is in the "Data Directory" the file "ExtTele1.csv" present and the file length greater 
than zero, the file is loaded in the transmission message 12 and sent. In each case, 
the file length is set to zero.

Ø Is in the "Data Directory" the file "ExtList1.csv" present and the file length greater than 
zero, the file is loaded into the list 12. In each case, the file length is set to zero. If the 
"Message designation" in the csv file begins with a number from 1 to 12, the file is 
loaded in the specified list.
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Ø Is in the "Data Directory" the file "ExtCmdRsp1.csv" present and the file length is 
greater than zero, the file is loaded into the command responses. In each case, the 
file length is set to zero.

Special case: Command file
Is in "Data Directory" the file "ExtList1.csv" present and the file length greater than zero and 
is on the first line, the keyword "LoadCsvFiles" the file is a command file. With a command 
file you can automatically load messages, lists, and the command responses. The lines of 
the command file have the following structure: Number; absolute or relative file name; The 
relative file names are looked up in the data directory. The number has the following 
meaning:
0 = load command responses
1-12 = load send list 1-12.
13-24 = load messages 1-12.
Example of a command file:
LoadCsvFiles;
0;CommandResponsesRtuEast.csv;
1;List-IC-Answer.csv;
4;MessageSurge.csv;
11;d:\W101\Data\IG_ListRtuEast.csv;
2;List_AllTypes.csv;
22;_TestCommand.csv;

Using a new log file every day, name: LogTT.lg1
When activating the option, a new log file will be created for each day of a month. The 
number of the day (01 - 31) is indicated in the file name. The files of the previous month will 
be overwritten in the following month.
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4.10 Dial up modem (Parameterize | Dial up modem)

Use this dialog box to specify and send modem commands (AT commands).

To call up the context menu, click with the right mouse button outside the input box. Using 
the related context menu items, you can save the modem parameters to a file or load them 
from a file.

Dial-up modem available on Receiver/Transmitter 1
Tick the corresponding checkbox in order to specify that a dial-up modem is connected to the 
COM port of Receiver/Transmitter 1. If a modem exists, the program waits for the connection 
message (connect) from the modem. During the delay time, you specify and send modem 
commands. The link is set up as soon as the connection message has been received.

Program status
This box shows the program status.

DCD status
Indicates the status of the ‘Data Carrier Detect’ modem signal

Modem commands
Specify the parameters of modem commands in these four input boxes. To send the
command, click the related “Send” button.

Break the connection
In this input box, enter the modem command for breaking a connection. Click the related
“Send” button in order to send the command. Before sending the command, the processing
of the link is interrupted for two seconds.

Max. time of a phone connection
The time is measured from the receipt of the connection message. As soon as the specified
time has expired, the program automatically sends the “Cut connection“ modem command.
Afterwards, the program waits again for a new connection message.

Receive telegram time out
An error-free telegram must be received within the specified time period. The connection is
cut as soon as this time has expired. Time measuring starts upon receipt of the connection
message.

Connection message
Enter the message for which the program has to wait. The link is set up as soon as the
program receives the message. Afterwards, it sends and receives 101 telegrams. 

After receiving the ‘RING’ msg., ‘ATA’ is sent
Tick the corresponding checkbox in order to specify that the program send automatically the 
AT command ‘ATA’, after receiving the ‘RING’ message.

OK
Clicking this button saves the current parameters and closes the modem window.

Toggle DTR
Click this button to toggle the “Data Terminal Ready” modem signal. In this context, toggling
means: Invert the DTR signal, wait two seconds, invert the DTR signal. Afterwards, the
program waits for the connection message.
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5 Filters

5.1 Parameterize Output filter (Filter | Output filter)

Key combination (if parameterized):  "F12"

With this dialogue field you parameterize the output filter. The output filter filters messages 
from the Log file for output to screen, printer or text file. The filter is active if you have 
parameterized at least one filter and not switched off the output filter, see Filter. An active 
output filter can be seen from the note in the Status bar and from the word "Filtered" in the 
header of the message output . All parameterized filter are linked with "and", i.e. all 
conditions must be met for the message to be output.

With filter selection or a right-click, you can save the filter settings to a file and load it from a 
file.

Filter selection
Allows you to select stored filter files or enter a new file name. If you close the window with 
"OK", the settings are saved in the specified file. The filter files are stored in the data 
directory and have the file extension "flt1".

Messages from
If marked then only those messages will be displayed whose time is after the parameterized 
time.

Messages until
If marked then only those messages will be displayed whose time is before the 
parameterized time.

Message status
With this parameter you select only correct or only faulty messages. If you mark both or no 
field then the Filter is off.

Message source
With this parameter you select messages from one receiver or transmitter If you mark both or 
no field then the filter is off.

Quality descriptor
Select the desired quality descriptor. Is not a quality descriptor selected, the filter is off. The 
abbreviations for the quality descriptors have the following meanings:
IV = Invalid
NT = Not topical
SB = Substituted
BL = Blocked
EI = Elapsed time invalid (protection equipment)
OV = Overflow

Message number
The messages in the log file are numbered (1-n). With this Filter you can select a 
section/range or one or two specific message numbers. 
Example: In the log file there are 1000 messages. 
1) You want to display the message 500. 
Enter: message number  equals  500  off  nn (nn = any number)
2) You want to display the messages 500 and 600.
Enter: message number  equals  500  or  600 
3) You want to display all messages apart from 500 and 600.
Enter: message number  unequal to  500  or  600 
4) You want to display the messages 500 to 600.
Enter: message number  equals  500  to  600 
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5) You want to display the messages 1-499 and 601-1000.
Enter: message number  unequal to 500  to  600 

Message length
Parameterize one or two length or a range.

Link function and PRM-Bit
Valid Entries: 0-15 and 64-79. Set the parameters for one or two numbers or a range. The 
program filters out only the link function (0-15 = Bit 0-3) and the Primary-bit (0/64 = bit 6). 
Bits 4, 5 and 7 are ignored.

Link address
Parameterize one or two addresses or a range. This filter only exists if the link address 
exists.

Message type 
Parameterize one or two types or a range.

Cause
Parameterize one or two Causes or a range.

Originator address
Parameterize one or two addresses or a range. This filter is only available if the originator 
address exists.

Station address
Parameterize one or two addresses or a range. If the station address is structured then there 
is a filter for each field. The highest value field will be designated the station address 1.

Object address
Parameterize one or two addresses or a range. If the object address is structured then there 
is a filter for each field. The highest value field will be designated the object address 1.

OK
Saves the settings, saves the filter file, closes the window, activates the filtering.

Reset filter
Resets the filter and removes the filter name in the filter selection.
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5.2 Parameterize Log Filter (Filter | Log filter)

With this dialogue field you parameterize the Log filter. The Log filter filters messages out of 
the received or transmitted messages for the storing in the Log file. The filter is active if you 
have parameterized at least one filter. You can see if a Log filter is active from a reference in 
the status bar. The parameterizing and the filter logic is the same as for the output filter, see 
Parameterize Output filter.

The filters for Time and for Message Number are particularly useful in Log Filter.

With the Time filter you can specify a time range in which the messages will be stored. For 
example: from  9.08.2000  22:00  to 10.08.2000  4:00.

With the filter of Message Number you can limit the number the stored messages. For 
example:  "Message number  equals 1  to 10000". If the log file is empty then you must 
parameterize from message number 1. If the log file is not empty then the "Message number 
to" must be greater than the number of messages in the log file.

The log file is organised as a circular buffer. If the file is full then the newest message 
overwrites the oldest message. You can prevent this by deleting the old messages before the 
test start (Ctrl+D) or increase the maximum size of the log file or filter the messages by time 
or/and by message number.

Note that only the stored messages will be displayed during On-line output. The message 
counter in the Status table counts all messages.
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6 Faults Simulation

6.1 Faults Simulation

For test and check purposes it can be sensible to transmit faulty messages or to react 
incorrectly to correct messages.

A message can be faulty in a variety of ways. The fault can be in the transmission layer, link 
layer or application layer.

Faults in the transmission layer are e.g. parity or frame faults in bytes. They can occur 
through a false/ incorrectly parameterized baud rate.

Faults in the link layer are e.g. false/incorrect start bytes, stop bytes, check bytes, length 
bytes, link code or link address. A part of the fault can occur if you have parameterized the 
length link address incorrectly.

Faults in the application layer are e.g. station or object address false/ incorrect, type, cause 
unknown, message length, structure identifier illogical, invalid cause to a specific type. A part 
of the fault can occur if you have intentionally  (or unintentionally) parameterized the length of 
the station address, object address, originator address (Cause) falsely/ incorrectly.

For specific fault simulation use the dialogue fields Link Test Rec/Trans and
Parameterize message . The dialogue field Link Test influences the Link messages
considerably and the Simulation File Transfer. Use the dialogue field Parameterize 
Message in the normal case to parameterize Data messages. However at the end of the 
type table you will find the two fictional types "ASDU as Hex String” and "Message as Hex 
String”. With these types you can simulate a variety of faults.

"ASDU as Hex String” means: You parameterize only the ASDU (from Type), the correct 
message packaging is inserted by the program. You can thus transmit private ASDUs or a 
standard ASDU modified intentionally without having to bother oneself with the check section 
or the link part. For example, you can modify the type, the cause, the structure, qualifier and 
time to any values you want. You can also insert bytes to make the ASDU length illogical.

"Message as Hex String” is ever more flexible. Here you can transmit whatever you want. 
You can send the messages with false/ incorrect link code, start bytes, length bytes, stop 
bytes, check bytes, etc. If you have parameterized a standard message before selection of 
the type "Message as Hex String” then this standard message will be output as a hex String. 
You can then modify it as desired and do not need to parameterize all the bytes.

In order to simulate faults it can be sensible to switch off the simulation. The program does 
not establish a link connection, does not acknowledge the messages automatically, does not 
wait for acknowledgement and only sends after an operation. If you have parameterized the 
link messages “Normieren Link” and “Single character E5” as hex String, you can establish 
the link per operation and acknowledge received messages. Use several messages to send 
false and correct messages one after another. Multiple transmissions are also possible.
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6.2 Link Test Rec/Trans 1/2 (Mode | Link test Rec/Tr. 1/2)

With this dialogue field you can change the simulation of the link level, the file transfers and 
the ASDUs. On leaving the dialogue field the program resets all options (nNormal status). 
You can only call this dialogue field if you have enabled it to be used, see WinPP101 
Options.

Send NACK instead of ACK;
If marked the every received message will be acknowledged with NACK.

Send DIR bits false;
If marked then the program sends  the direction bits inverted.

Send PRM bits false;
If marked then the program sends the primary bits inverted.

Do not toggle FCB bits;
If marked then the program does not toggle the frame count bit.

Send FCV bits false/ incorrect;
If marked then the program sends the frame count valid bits inverted.

Send ACD bits equal to 1;
If marked then the program sets the access demand bits in the secondary messages. In 
balanced operation the reserved bits will be set.

Send DFC bits equal to 1;
If marked then the program sets the data flow control bits in the secondary messages.

Send no ASDUs;
If marked then the program sends no more data messages (ASDUs). However the Link layer 
will continue to be simulated.

Send/Acknowledge file transfer CHS incorrectly;
This parameter is connected to Simulation File Transfer. If marked the program always 
interprets a received checksum byte as false. If the program sends a checksum byte then it 
adds a 1 to the correct value.

Send File transfer SCQ = deactivate;
This parameter is connected to the Simulation File Transfer. If marked the program 
acknowledges the message "Section ready” (F_SR_NA_1) with "Section abort". The partner 
station should then offer the next section.

7 Simulation File Transfer

The description and log examples see the online help of the program.
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8 Message structure

Normative references:

IEC 60870-5-1 Transmission frame formats
IEC 60870-5-2 Link transmission procedures
IEC 60870-5-3 General structure of application data
IEC 60870-5-4 Definition and coding of application information’s elements
IEC 60870-5-5 Basic application functions
IEC 60870-5-101 Companion standard for basic Telecontrol tasks

The companion standard -101 admits exclusively frame formats FT1.2 that is defined in IEC 
60870-5-1.
Formats with fixed and with variable block length are admitted.

Formats with variable block length are Data messages. 
Formats with fixed block length are Link messages.
Also the single control character one (Hex: E5) is admitted.

Transmission rules:
Ø Line idle is binary 1.
Ø Each character has one start bit (binary 0), 8 information bits, one even parity bit and 

one stop bit (binary 1).
Ø No line idle intervals are admitted between characters of a frame.
Ø Upon detecting an error, a minimum interval of 33 line idle bits is required between 

frames.
Ø The sequence of user data characters is terminated bay a 8 bits check sum (CS).

The check sum is the arithmetic sum disregarding overflows (sum modulo 256) over 
all user data octets.

The receiver checks:
Ø per character: the start bit, the stop bit and the even parity bit.
Ø per frame: the specified start character at the beginning and at the end of the frame 

header.
Ø the identity of the two length specifications L.
Ø that the number of received characters is equal to L + 6.
Ø the frame check sum.
Ø the end character.

The frame is rejected if one of these checks fails; otherwise it is released to the user.

http://www.ppfink.de


Operating instructions WinPP101 April 2015

Reinhard Fink Ingenieurbuero www.ppfink.de Page 41

8.1 Format data message

{bmct DuDTel.bmp}

8.2 Format ASDU
ASDU = Application Service Data Unit.
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8.3 Format link message

Control field balanced transmission

DIR  physical transmission direction
1 station A to station B
0 station B to station A

FCB frame count bit 
FCV frame count bit valid
DFC data flow control
PRM primary message

Function codes of primary message
0 Reset of remote link (send/confirm)

  1 Reset of user process (send/confirm)
  2 Test function for link (send/confirm)
  3 User data (send/confirm)
  4 User data (send/no reply)
 5-8 Reserved
  9 Request status of link (request/respond)
10-15 Reserved

Function codes of secondary message
0 ACK: positive acknowledgement (confirm)

  1 NACK: message not accepted, link busy (confirm)
 2-10 Reserved
 11 Status of link (respond)
12-13 Reserved
 14 Link service not functioning 
 15 Link service not implemented
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Control field unbalanced transmission

RES reserved
FCB frame count bit 
FCV frame count bit valid
DFC data flow control
PRM primary message
ACD access demand

Function codes of primary message
0 Reset of remote link (send/confirm)

  1 Reset of user process (send/confirm)
  2 Reserved
  2 Test function for link (send/confirm)
  3 User data (send/confirm)
  4 User data (send/no reply)
 5-7 Reserved
  8 Expected response specifies access demand (request 

for access demand)
  9 Request status of link (request/respond)
 10 Request user data class 1 (request/respond)
 11 Request user data class 2 (request/respond)
12-15 Reserved

Function codes of secondary message
0 ACK: positive acknowledgement (confirm)

  1 NACK: message not accepted, link busy (confirm)
 2-7 Reserved
  8 User data (respond)
  9 NACK: requested data not available (respond)
 10 Reserved
 11 Status of link or access demand (respond) 
12-13 Reserved
 14 Link service not functioning 
 15 Link service not implemented
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